
  

 

 
 
 
 
 
  

 

  
  
 
  

 

   

 

 

 
 

The smart way to learn
Microsoft Outlook 2013

—one step at a time!

Experience learning made easy—and quickly teach yourself 
how to create your own database with Microsoft Access 2013. 
With Step by Step, you set the pace—building and practicing 
the skills you need, just when you need them!

Cox
Lambert

• Build a custom database from scratch or templates
• Create forms to enter, edit, and display data
• Write queries to extract and manipulate data
• Import data from other databases and documents
• Design, run, and print reports, and add subreports
• Help prevent data corruption and unauthorized 

access

Your Step by Step digital content includes:
• All the book’s practice files—ready to download at: 
http://aka.ms/Access2013sbs/files
• Fully searchable ebook. See the instruction page at 

the back of the book.

M
icrosoft O

utlook 2013

Follow the easy numbered steps 

Use screenshots to check your work

Get helpful tips and pointers

Build your skills hands-on with 
ready-made practice files
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Build exactly the skills you need. 

Learn at the pace you want.
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Introduction
Part of the Microsoft Office 2013 suite of programs, Microsoft Outlook 2013 is a sophisti-
cated communication-management program that helps you quickly and efficiently manage 
messages, schedules, address books, and other information. Microsoft Outlook 2013 Step by 
Step offers a comprehensive look at the features of Outlook that most people will use most 
frequently.

Who this book is for
Microsoft Outlook 2013 Step by Step and other books in the Step by Step series are designed 
for beginning to intermediate-level computer users. Examples shown in the book generally 
pertain to small and medium-sized businesses but teach skills that can be used in organi-
zations of any size. Whether you are already comfortable working in Outlook and want to 
learn about new features in Outlook 2013 or you are new to Outlook, this book provides 
invaluable hands-on experience so that you can manage communications and information 
with ease.

How this book is organized
This book is divided into three parts. Part 1 explores the everyday experience of working in 
Outlook 2013. Part 2 discusses ways of managing content within Outlook to maximize your 
productivity. Part 3 delves into the management of Outlook itself, and ways of customizing 
program functionality and the appearance of the program window to fit the way you work. 
This three-part structure allows readers who are new to the program to acquire basic skills 
and then build on them, whereas readers who are comfortable with Outlook 2013 basics 
can focus on material that is of the most interest to them.

Chapter 1 contains introductory information that will primarily be of interest to readers who 
are new to Outlook or aren’t familiar with the process of configuring Outlook to connect to 
an email account. If you are comfortable managing accounts in a recent version of Outlook, 
you might want to skip directly to Chapter 2.
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This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform with Outlook 2013. If you start at the beginning and work your 
way through all the exercises, you will gain enough proficiency to be able to manage com-
munications, contacts, tasks, and calendars. However, each topic is self-contained, so you 
can jump in anywhere to acquire exactly the skills you need.

Download the practice files
Before you can complete the exercises in this book, you need to download the book’s prac-
tice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/Outlook2013sbs/files

IMPORTANT  The Outlook 2013 program is not available from this website. You should 
purchase and install that program before using this book.

As you work through the exercises in this book, you will create Outlook items that you will 
use as practice files in later exercises. If you do not complete the earlier exercises, you can 
substitute Outlook items of your own and modify the exercise settings to fit.

The following table lists the practice files for this book.

Chapter Use these files and items Create these files and items
Chapter 1: 
Get started with 
Outlook 2013

No practice files required None

Chapter 2: 
Explore 
Outlook 2013

No practice files required None

Chapter 3: 
Send and receive 
email messages

	We provide:
NaturalGardening.pptx
Procedures.docx

SBS First Draft message series
SBS Tradeshow Schedule message

Chapter 4: 
Store and access 
contact information

No practice files required Contact records for Ben Miller, Dean 
Halstead, Jill Frank, Lola Jacobsen, and 
Sarah Jones
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Chapter Use these files and items Create these files and items
Chapter 5: 
Manage scheduling

No practice files required SBS Lunch with Jane appointment
SBS Pay Day event
SBS Staff Meeting appointment
SBS Study Session meeting

Chapter 6: 
Track tasks

	You provide:
SBS First Draft message
SBS Tradeshow Schedule message

	Flagged SBS First Draft message
Flagged SBS Tradeshow Schedule 
message
SBS Make Dinner Reservations task
SBS Order Brochures task
SBS Send Dinner Invitations task

Chapter 7: 
Organize your 
Inbox

	You provide:
SBS First Draft message series
SBS Tradeshow Schedule message

	SBS Messages folder

Chapter 8: 
Manage your 
calendar

No practice files required Secondary calendar

Chapter 9: 
Manage contact 
records

	We provide:
JoanLambert.jpg
SBSContacts.csv

You provide:
Contact records for Ben Miller, Dean 
Halstead, Jill Frank, Lola Jacobsen, and 
Sarah Jones

	Contact records for Delphine Ribaute, 
Max Stevens, and Sara Davis
SBS Contacts address book
SBS Project Team contact group

Chapter 10: 
Enhance message 
content

	We provide:
Lighthouse.jpg

	Casual email signature
SBS Development Process message
SBS Picture Tools message

Chapter 11: 
Customize Outlook

No practice files required None

Chapter 12: 
Manage email 
settings

No practice files required Flagged SBS Quick Message message
SBS Messages folder
SBS rule

Chapter 13: 
Work remotely

No practice files required None
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Your companion ebook
With the ebook edition of this book, you can do the following:

▪▪ Search the full text

▪▪ Print

▪▪ Copy and paste

To download your ebook, please see the instruction page at the back of the book.

Get support and give feedback
The following sections provide information about getting help with this book and contact-
ing us to provide feedback or report errors.

Errata
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on 
our Microsoft Press site, which you can find at:

http://aka.ms/Outlook2013sbs/errata

If you find an error that is not already listed, you can report it to us through the same 
page.

If you need additional support, email Microsoft Press Book Support at:

mspinput@microsoft.com

Please note that product support for Microsoft software is not offered through the  
addresses above.
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We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable 
asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at: http://twitter.com/MicrosoftPress.
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Get started with 
Outlook 2013

IN THIS CHAPTER, YOU WILL LEARN HOW TO

▪▪ Identify new features of Outlook 2013.

▪▪ Connect to email accounts.

▪▪ Troubleshoot connection problems.

▪▪ Work in the Outlook 2013 user interface.

▪▪ Get help with Outlook 2013.

Bill Gates’s dream of “a computer on every desktop” is becoming more and more of a reality 
—many people today work (and play) on computers both at work and at home. However, 
the digital world is rapidly expanding beyond that original dream—desktop computers 
turned out to be only the beginning. Laptops, netbooks, tablets, slates, and other por-
table computers, as well as smartphones such as Windows Phones, iPhones, and Android 
phones that run mobile applications are becoming a standard part of the productivity 
package. Electronic messaging—whether email, social network updates, instant messages, 
or text messages—keeps many of us in contact with colleagues, clients, friends, and family 
members for a dizzying portion of each day. For people who are dependent on electronic 
communications—and even more so for those who work in enterprises that use Microsoft 
Exchange Server, SharePoint, and Lync to manage collaboration—Microsoft Outlook 2013 
offers an ideal solution. Outlook 2013 not only provides email functionality, but also in-
tegrates with instant messaging programs and Microsoft SharePoint resources. Outlook 
enables you to manage messaging and information—address books, calendars, task lists, 
and more—in one attractive interface. More importantly, Outlook makes this information 
immediately available to you when and where you need it. From one place, you can quickly 
store, organize, manage, and retrieve many types of information.

In an enterprise environment, Outlook interacts with Microsoft server products to provide 
unified communications services including real-time presence and status information, spe-
cialized functionality for internal messaging, access to fax messages and voice mail mes-
sages, offline access to SharePoint site content, and many other useful features. 
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You can use Outlook to:

▪▪ Send, receive, read, respond to, organize, and archive email messages.

▪▪ Create attractive business graphics and incorporate and edit external images in your 
communications.

▪▪ Send documents, spreadsheets, presentations, pictures, and other files as message 
attachments, and preview attachments you receive from other people.

▪▪ Schedule events, appointments, and meetings; invite attendees; and reserve conference 
rooms, projectors, and other managed resources.

▪▪ View upcoming appointments and tasks, and receive reminders for them.

▪▪ Share schedule information with other people, inside and outside your organization.

▪▪ Store contact information in a transferable and easily accessible format.

▪▪ Keep track of tasks you need to complete, schedule time to complete your tasks, and 
assign tasks to co-workers.

▪▪ Organize and easily locate information in messages, attachments, calendars, contact 
records, tasks, and notes.

▪▪ Filter out unwanted and annoying junk messages.

▪▪ Have information from favorite websites delivered directly to you.

In this chapter, you’ll get an overview of the new features in Outlook 2013 to help you iden-
tify changes if you’re upgrading from a previous version. Then you’ll configure Outlook to 
connect to one or more email accounts, and explore the program’s user interface. Finally, 
you’ll learn how to get help with the program.

PRACTICE FILES  You don’t need any practice files to complete the exercises in this chapter. 

Microsoft Office 2013 encompasses a wide variety of programs, including Microsoft Access 
2013, Excel 2013, InfoPath 2013, Lync 2013, OneNote 2013, Outlook 2013, PowerPoint 2013, 
Publisher 2013, and Word 2013. Office is available in various editions that include different 
combinations of Office programs; you can also purchase most of the programs individually.



The programs in the Office suite are designed to work together to provide highly efficient 
methods of getting things done. You can install one or more Office programs on your com-
puter, or work with online versions of some programs in a web browser. Some programs 
have multiple versions designed for different platforms. Although the core purpose of a 
program remains the same regardless of the platform on which it runs, the available func-
tionality and the way you interact with the program might be different.

The program we work with and depict in images throughout this book is a desktop instal-
lation of the Outlook 2013 client application for Windows, which we installed directly on 
our computers. The standard client installation has all the available Outlook functionality. 
It is available as part of the Office 2013 suite of programs, as a freestanding program, or as 
part of an Office 365 subscription that allows users to install desktop programs from the 
Internet.

TIP  Office 365 is a cloud-based solution that small, midsize, and large businesses can use to 
provide products and services to their employees through a subscription licensing program.

Outlook Web App
Outlook Web App is a browser-based version of Outlook that supports much of the 
desktop installation functionality. You can perform many of the same functions in 
Outlook Web App that you can in a desktop installation of Outlook, from within a  
web browser window. Outlook Web App is available as part of Office 365 subscriptions 
and Exchange Server installations. The functionality of Outlook Web App is dependent 
on the version you’re using. Recent versions of Outlook Web App have an appearance 
and functionality similar to that of the Outlook 2013 client.

If Outlook Web App is available for your email account, you can access it by entering 
an organization-specific URL in a web browser or by clicking the Access This Account 
On The Web link on the Info page of the Backstage view of the Outlook client. The 
most recent version of Outlook Web App can be run with varying levels of function-
ality in the Windows Internet Explorer, Firefox, Safari, and Chrome web browsers on 
computers that run Windows, Mac OS, or Linux. The available functionality depends 
on the specific combination of web browser and operating system.
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Identifying new features of Outlook 2013
Outlook 2013 builds on previous versions to provide powerful information-management 
and communication tools. If you’re upgrading to Outlook 2013 from a previous version, 
you’re probably most interested in the differences between the old and new versions and 
how they will affect you, and want to find out about them in the quickest possible way. In 
this section, we discuss features that are new in Outlook 2013 or have been removed from 
this version of Outlook.

Significant changes have been made from previous versions of Outlook. If you’re upgrad-
ing from Outlook 2007 or Outlook 2003, you might find that some of the changes take a 
bit of getting used to—particularly the global incorporation of user interface elements such 
as the ribbon and the Quick Access Toolbar, and the movement of program-management 
functionality to the Backstage view. These elements have been carefully designed to pro-
vide intuitive access to tools and commands; however, you do have many options for per-
sonalizing your Outlook 2013 working environment to suit your preferences.

If you are upgrading from Outlook 2010, you will encounter the following new features in 
Outlook 2013:

▪▪ Simplified user interface  Outlook 2013 has a sleek new look with subtle coloring 
and simplified iconography. 

▪▪ Folder Pane  The Folder Pane (formerly called the Navigation Pane) is now dedicated 
to the display of account folder structures, and no longer contains the module navi-
gation links.

▪▪ Navigation Bar  Outlook module links have moved from the former Navigation Pane 
to a separate Navigation Bar in the lower-left corner of the program window. The stan
dard Navigation Bar contains text links and the compact Navigation Bar, which is on by 
default, contains only module buttons.

▪▪ Message list functionality  It’s now easier to manage messages directly from the 
message list. The default view displays the message subject, sender, and first line of 
content of each message. Many message status and content indicators and response 
options are available from the message list and from the Reading Pane. You can 
easily display only new messages by clicking the Unread button at the top of the 
message list.
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▪▪ Inline replies  By default, message responses are drafted directly in the Reading Pane 
so you don’t have to manage an extra message window. If you prefer to work in a 
separate window, you can “pop out” the response draft.

▪▪ Module preview  You can quickly peek at current information in the Calendar, People, 
or Tasks module by pointing to the module link or button on the Navigation Bar. You 
can pin these module “peeks” to the To-Do Bar.

▪▪ Multiple-source contact information  In the new People Card view, a single contact 
record can display contact information about a person from multiple sources, includ-
ing Outlook, Microsoft Lync, and social networks such as LinkedIn. You can initiate 
many types of interactions with a person directly from the contact card.

▪▪ Site mailbox connections  If your organization uses shared site mailboxes on a 
SharePoint 2013 site, you can access messages and documents in site mailboxes of 
which you are a member directly from the Outlook Folder Pane.

▪▪ Exchange ActiveSync support  You can connect to email accounts that support 
ActiveSync, such as a Windows Live Hotmail or Outlook.com account, without install-
ing additional software. Then you can synchronize information such as Hotmail tasks 
with Outlook so that you can easily work with your business and personal accounts 
from one location.

▪▪ Weather Bar  With this fun new addition to Outlook, you can display current weather 
conditions in the Calendar module. You can add multiple locations to the Weather 
Bar and easily display the current conditions for a location by selecting it from a list.

As is always the case with developing technologies, some features that were available in 
previous versions of Outlook are now redundant due to technological or procedural 
changes. Of these, features that we have discussed in earlier editions of this book and 
that have been modified include the Notes and Journal features. If you used these fea-
tures in previous versions of Outlook, here’s what you need to know:

▪▪ The Notes and Journal folders are still available in the Folder List, and the Notes 
module is available from the Navigation Bar.

▪▪ Notes and Journal options are not available in the Outlook Options dialog box.

▪▪ The automatic journaling functionality has been disabled. You can create Journal 
entries, but only manually.

▪▪ You can create new notes, but only with the default color and font settings.
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The following table describes other features that have been discontinued or modified in 
Outlook 2013.

Feature Description
Data files Outlook 2013 does not support the creation of Outlook  

97-2002 Data Files (.pst files). If you upgrade to Outlook 
2013, existing .pst files are available from the Folder Pane. 
New Exchange Server account items are delivered to an 
offline Outlook Data File (.ost file). Cached Exchange Mode 
is on by default.

Importing and exporting Options for importing Internet email account settings, 
messages, and addresses are discontinued. Options for 
exporting Outlook data as tab-separated values and 
directly to Microsoft Access and Excel are no longer 
supported.

Dial-up networking support Outlook 2013 uses the network connections configured 
in Windows; it is not necessary to separately configure a 
dial-up connection in Outlook.

Exchange Server classic offline mode This feature is discontinued. Exchange Server accounts can 
be used online or in Cached Exchange Mode.

Exchange Server Download Headers 
And Then Full Items mode

This feature has been discontinued. After you upgrade 
to Outlook 2013, if you had this option selected, it is 
automatically changed to Download Full Items

Connecting to email accounts
By using Outlook 2013, you can easily manage one or more email accounts and the infor-
mation (such as calendar items and contact records) associated with those accounts. You 
can configure Outlook to connect to many different types of business and personal email 
accounts. If your organization uses Exchange Server, you can use Outlook to work with all 
the features of your Exchange account, including email, calendaring, contact tracking, task 
tracking, and notes. If your organization also uses Lync Server features, you can initiate audio 
and video calls, instant messaging sessions, online meetings, and more from Outlook 2013.

Although you don’t have to connect to an email account to use Outlook, it is customary to 
do so. After you configure Outlook to connect to an account, you can easily manage the 
information stored with that account by using the Outlook features specifically designed for 
each type of information.
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A default installation of Outlook 2013 supports the following types of email accounts:

▪▪ Exchange  You can configure Outlook 2013 to connect to an Exchange account 
hosted on Exchange Server 2013, Exchange Server 2010, Exchange Server 2007, or 
Exchange Server 2003. If your organization uses any of these versions of Exchange 
Server, you can send mail within or outside of your organization’s network. Messages 
are stored centrally on the Exchange server. They are also stored locally in a data file 
on your computer. Outlook synchronizes with the server when you’re connected to 
it either over a corporate network or over the Internet, so you can work with existing 
Outlook items and create new items while working offline.

In previous versions of Outlook and Exchange, you could connect to a corporate 
Exchange account only when your computer was connected to the corporate network.  
This required that you manually configure Outlook to connect to the corporate 
Exchange server either through a virtual private network (VPN) connection or by 
using Outlook Anywhere (a friendly name for a service otherwise known as RPC 
over HTTP) when you wanted to work in another location. More recent versions of 
Exchange automatically route all Outlook client access through Outlook Anywhere 
and do not require a direct corporate network connection.

TIP  Some Outlook features are dependent on the functionality of the specific version 
of Exchange hosting your email account. The functionality described in this book is 
specific to Exchange Server 2010 accounts. Outlook provides additional functionality 
in environments that include Lync Server and SharePoint.

▪▪ Exchange ActiveSync–compatible service  Although this sounds quite techni-
cal, it’s simply a description for an Internet-based email service such as Hotmail or 
Outlook.com. It is no longer necessary to install a separate connector in order to 
configure Outlook 2013 to connect to an account of this type.

▪▪ Post Office Protocol (POP)  When connected to a POP account, Outlook downloads 
messages from your email server to your computer, and removes the original messages 
from the server after a specified length of time. You read and manage messages on 
your computer, and Outlook synchronizes with the server when it is connected.

▪▪ Internet Message Access Protocol (IMAP)  When connected to an IMAP account, 
Outlook stores copies of messages on your computer, but leaves the originals on the 
email server. You read and manage messages locally, and Outlook synchronizes with 
the server when it is connected.
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Before you can use Outlook to manage an email account, you need to configure the pro-
gram to connect to the account. When you first start the program, the Microsoft Outlook 
Account Setup wizard guides you through an automated process. This process is a signifi-
cant improvement over the manual account setup process of Outlook 2003 and earlier ver
sions of Outlook, which required you to provide much more information. For many accounts,  
you need to supply only three pieces of information—your name, your email address, and 
your email account password—and the Account Setup wizard will handle the rest of the 
connection process for you. If the Account Setup wizard isn’t able to configure Outlook to 
connect to your account, you can provide additional information to complete the process 
manually.

Configuring Outlook creates an Outlook Data File for each email account and an Outlook 
profile, which stores information about you and your email accounts. You can work with 
your profile from within Outlook or from the Mail control panel in Windows. Your profile 
includes information about your email account such as the user name, display name, server 
name, password, and where Outlook stores your data. You can connect to more than one 
email account per profile, to manage all your email communications through Outlook. If 
you want to, you can create multiple profiles that link to different email accounts or to dif-
ferent sets of email accounts, but it is no longer necessary to create multiple profiles to 
manage multiple accounts.

You can add multiple email accounts of any type to your Outlook profile, either during 
setup or at any time thereafter.
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Adapting exercise steps
The screen images shown in this book were captured at a resolution of 1024 × 768, 
at 100 percent magnification. If your settings are different, the ribbon on your screen 
might not look the same as the one shown in this book. For example, you might have 
more or fewer buttons in each group, the buttons you have might be represented by 
larger or smaller icons than those shown, or a group might be represented by a but-
ton that you click to display the group’s commands. As a result, exercise instructions 
that involve the ribbon might require a little adaptation. Our instructions use this 
format:

▪▪ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, our instructions use this format:

▪▪ On the Home tab, in the Filter Email group, click the Categorized arrow and 
then, in the Categorized list, click Any Category.

TIP  On subsequent instances of instructions located on the same tab or in the same 
group, the instructions are simplified to reflect that we’ve already established the 
working location.

If differences between your display settings and ours cause a button to appear differ-
ently on your screen than it does in this book, you can easily adapt the steps to locate 
the command. First click the specified tab, and then locate the specified group. If a 
group has been collapsed into a group list or under a group button, click the list or 
button to display the group’s commands. If you can’t immediately identify the button 
you want, point to likely candidates to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while 
you read and work through the exercises in this book.

In this book, we provide instructions based on the traditional keyboard and mouse in-
put methods. If you’re using Outlook on a touch-enabled device, you might be giving 
commands by tapping with a stylus or your finger. If so, substitute a tapping action 
any time we instruct you to click a user interface element. Also note that when we tell 
you to enter information in Outlook, you can do so by typing on a keyboard, tapping 
an on-screen keyboard, or even speaking aloud, depending on your computer setup 
and your personal preferences.
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In this exercise, you’ll configure Outlook to automatically connect to an Exchange Server 
account, and you’ll manually configure the account settings.

TIP  Although we demonstrate connecting to an Exchange account, the basic process is the 
same to connect to another type of email server. To connect to a POP or IMAP account,  
you should first read the topic “Connecting to Internet email accounts” in “Troubleshooting 
connection problems” later in this chapter.

	SET UP  You don’t need any practice files to complete this exercise. You need your 
email account user name and password. If you are connecting to a POP account, an IMAP 
account, or an Exchange account that is hosted by an external service provider, you 
might also need to know the names and authentication requirements of your incoming 
and outgoing servers. These will be available from your email service provider.

1	 Start Outlook by using one of the following methods:

▪▪ On a computer that runs Windows 8, display the Start screen, enter Outlook, and 
then click the Microsoft Outlook 2013 icon.

▪▪ On a computer that runs Windows 7, click the Start button, click All Programs, 
click Microsoft Office, and then click Microsoft Outlook 2013.

TIP  If the Email link at the top of the Start menu specifies Microsoft Outlook as 
your default email program, you can click that link instead.

2	 The next step depends on whether Outlook is already configured.

▪▪ If Outlook has not yet been configured, the Microsoft Outlook Account Setup 
wizard begins. On the Welcome page, and again on the Add an Email Account 
page, click Next to display the Auto Account Setup page of the Add Account 
wizard.

TIP  To configure an Outlook profile without connecting to an email account,  
start the program, click Next on the Welcome page, click No and then Next on  
the Add An Email Account page, select the Use Outlook Without An Email  
Account check box, and then click Finish.

▪▪ If an Outlook profile has already been configured, the program starts. Manually 
start the account configuration process by clicking the File tab at the left end of 
the ribbon to display the Info page of the Backstage view, and then clicking Add 
Account to display the Auto Account Setup page of the Add Account wizard.
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TIP  You control Outlook program settings from the Backstage view. For  
detailed information, see “Configuring Office and Outlook options” in  
Chapter 11, “Customize Outlook.”

The Add Account wizard, which you can start from the Account Setup wizard or  
from the Info page of the Backstage view.

3	 On the Auto Account Setup page of the Add Account wizard, enter your name, 
email address, and email account password in the text boxes provided. Then click 
Next to search your available networks and the Internet for the specified domain.

TIP  The password characters you enter are hidden, so ensure that the Caps Lock key 
is not inadvertently active when you enter the password.

The wizard searches for the domain that hosts your account and attempts to  
log on to it by using the credentials you provided in step 3.
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If the wizard locates an account matching the email address you entered, it attempts 
to log on by using the password you entered. If the connection is successful, a confir-
mation appears, along with additional account configuration options.

After successfully configuring a connection to an email account, you can connect 
to another account, or click Finish to begin using the account.

If the wizard is unable to connect to the account without further information, an 
error page appears.

The specific message that appears might differ from the one shown here.

The next step depends on whether Outlook successfully connected to your account.

4	 If the wizard successfully connected to your account, click Finish. Click the File tab to 
display the Info page of the Backstage view, click the Account Settings button, and 
then click Account Settings. In the Account Settings dialog box, double-click your 
account. Then skip to step 11 to practice configuring additional settings. 
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5	 If the wizard didn’t connect to your account, click Back to return to the Auto Account 
Setup page (shown in step 2 of this exercise). Then select the Manual setup or 
additional server types option, and click Next to display the Choose Service page.

You can manually configure a connection to any of the account types supported  
by Outlook.

6	 On the Choose Service page, click the type of account you’re configuring (we chose 
Microsoft Exchange), and then click Next.

IMPORTANT  The screen that appears next varies based on the selected account type. 
If the screen that appears to you is not shown in this exercise, see “Troubleshooting 
connection problems” later in this chapter for more information.

7	 On the Server Settings page, enter the name or address of your Exchange server 
(provided by your Exchange server administrator) and your user name (usually your 
email address) in the boxes provided, and then click Check Name. 

8	 If the Connect to dialog box appears, enter your logon information, and then click 
OK to contact the specified server. If the user name and password you provided 
match the information stored on the server, the wizard replaces your user name 
with your display name (as recorded in your organization’s Global Address List) and 
underlines it. (This is known as resolving the address.)

If the wizard is unable to validate the information, an error message appears. (This 
might occur if you’re connecting to a corporate Exchange server over the Internet, 
and Outlook requires additional information to establish the connection.) Click OK in 
the message box to open a simple Microsoft Exchange dialog box that contains only 
a General page displaying the Exchange server and mailbox information. Then click 
Cancel to return to the Server Settings page.
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Possible results of attempting to validate Exchange account credentials.

If the wizard successfully resolves your server name and user name, you can begin 
using your account, or you can manually configure additional account settings. For 
the purpose of this exercise, we’ll look at the manual configuration options.

9	 On the Server Settings page, click More Settings to open the Microsoft Exchange 
account settings dialog box, displaying the General page. On this page, you can 
specify the name that identifies the account within Outlook (for example, on the title 
bar of the program window and in the Folder Pane). This setting does not affect the 
name that appears to message recipients.

10	 Enter the name by which you would like to identify this account. For example, your 
name, the email address, or the company name that this account represents.

The General page of the Microsoft Exchange account settings dialog box.
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Now we’ll review the available settings.

11	 Click the Advanced page tab. On this page, you can specify additional mailboxes 
on the same Exchange server that you want to open in Outlook. 

If you are responsible for monitoring another mailbox, such  
as a departmental mailbox, you can specify it here.

SEE ALSO  For information about Cached Exchange Mode, see “Working with Outlook 
items while offline” in Chapter 13, “Work remotely.”

12	 On the Advanced page, click the Outlook Data File Settings button to display 
information about the data file in which a copy of your email account information 
is stored on your computer. The Compact Now button is not active until you start 
using your account. (At this point, there’s nothing in the data file to compact.) 

You can reduce the data file size by compacting its contents.
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13	 Click the Security page tab. On this page, you can choose to help secure your locally 
stored account data by requiring logon credentials each time you start Outlook.

If other people have access to your computer, you can add an additional layer of security  
by instructing Outlook to access this account only if you enter the account credentials.

14	 Click the Connection page tab. On this page, you can specify whether you want 
Outlook to connect to the Exchange server through your local area network or over 
the Internet.

Selecting this option causes Outlook to connect to the server over the Internet.

TIP  If you are accustomed to using a previous version of Outlook, you might wonder 
where the network connection settings that were previously available from this page 
have gone. Outlook now uses the Windows network connection settings; you don’t 
need to enter any additional information in the program configuration.
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15	 On the tabs of the Microsoft Exchange dialog box, enter any additional connection 
information provided to you by your email server administrator, and then click OK.

16	 On the Server Settings page of the Add Account wizard, click Next. Then on the 
wizard’s final page, click Finish. The E-mail page of the Account Settings dialog box 
might appear and display the new email account.

You can manage Outlook settings for all the email accounts, RSS feeds, SharePoint lists, 
calendars, and address books you connect to from the Account Settings window.

17	 If the Account Settings dialog box opens, close it to display the Outlook program 
window.

While Outlook finishes configuring the connection to your account, a notice appears 
in the lower-right corner of the screen. After it connects to your account, any mes-
sages that you have appear in your Inbox.

TIP  Outlook might prompt you to select update settings. Options include Use Rec-
ommended Settings, Install Updates Only, and Ask Me Later. The recommended 
settings install updates and connect your Office installation to a customer feedback 
program that permits Microsoft to gather data about typical usage. Your participa-
tion in the program is entirely anonymous and does not give Microsoft access to 
your personal information or to the contents of messages or of files stored on your 
computer.

+ 	CLEAN UP  You’re now ready to begin using your email account!



20      Chapter 1  Get started with Outlook 2013 

Troubleshooting connection problems
The automatic account setup feature is very handy, but might not work every time. It is 
most successful when connecting to an on-premises Exchange account. When connecting 
to a remote Exchange server, to an Exchange account hosted by an external hosting com-
pany, or to a POP or IMAP account, manual configuration steps might be necessary.

Connecting to Exchange accounts
Here are some common error messages and problems you could encounter when you 
connect to an Exchange account, and how to address them:

▪▪ Server certificate does not match site  If Outlook encounters security issues associ-
ated with the electronic file (digital certificate) that validates the mail server’s identity 
—for example, if the digital certificate does not match the name of your domain—
Outlook notifies you of this problem and lets you choose whether to proceed.

If a Security Alert message box appears, you can click the View Certificate button to 
display the digital certificate of the mail server and verify that you know and trust 
the company that issued the certificate. If you want, you can install the certificate on 
your computer by clicking the Install Certificate button and following the steps in the 
Certificate Import wizard.

SEE ALSO  For more information about digital certificates, see “Increasing email 
security” in Chapter 12, “Manage email settings.”

▪▪ Encrypted connection not available  This message might appear if your Exchange 
account is with a hosted service provider. Outlook first tries to establish an encrypted 
connection to the server. If this attempt is not successful, Outlook notifies you of this 
problem and asks whether you want to try to establish an unencrypted connection. 

If you click Next to establish an unencrypted connection, Outlook might inadvertently 
configure the connection to your Exchange account as it would a connection to an 
IMAP or POP account. This configuration can result in a loss of functionality related 
to information, such as appointments and tasks, stored on the Exchange server. The 
more likely solution to this issue is to click the Back button, click the Manual Setup 
Or Additional Server Types option, click Next, and then manually enter the server and 
connection information for your account.
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If you encounter either of these errors when connecting to an Exchange account, verify that 
you are using the correct internal server address method. For example, if your email address 
is jane@adatum.com, you might address your email server as mail.adatum.com or by an in-
ternal address, such as ADATUMExchange.adatum.local.

To successfully troubleshoot your connection issues, you will likely need to manually config-
ure your server settings. This requires that you have additional information from your server 
administrator about your email account, including the names of the incoming and outgoing 
servers, and whether either of the servers requires additional authentication.

Connecting to Internet email accounts
If the Add Account wizard is unable to automatically configure a connection to your POP 
or IMAP account, you can manually configure the connection.

The basic information required to connect to a POP or IMAP account.
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In addition to your name and email address, you must provide the following information, 
which you can obtain from your email service provider:

▪▪ Account type  Choose POP3 or IMAP from the drop-down list.

▪▪ Incoming and outgoing mail servers  Server addresses are usually entered in the 
format server.domain.com.

▪▪ Account user name  Many providers require that you enter the entire email address 
for this parameter rather than only the name before the @ symbol.

▪▪ Account password  Outlook disguises the password characters as asterisks.

▪▪ Logon authentication requirements  Some mail servers require that you log on by 
using secure password authentication.

Click the More Settings button to open the Internet E-mail Settings dialog box in which you 
can enter additional information, such as the name by which you want to identify the ac-
count, the email address you want to appear when you reply to a message, and outgoing 
server authentication information.

It might be necessary to supply additional server authentication information.

The default account settings are for unencrypted connections. Your mail account provider 
might require that you use encrypted connections for your incoming server, outgoing server, 
or both. Selecting the This Server Requires An Encrypted Connection check box on the 
Advanced page of the Internet E-mail Settings dialog box changes the Incoming Server port 
to 995 and directs email traffic through the HTTPS protocol rather than the HTTP protocol.

It is important to note that when connecting to a POP account, you can control the reten-
tion of messages on the email server. By default, messages downloaded from a POP server 
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to your computer are removed from the server after 14 days. You can choose to leave the 
messages on the server permanently, leave them there for a specified amount of time, or 
leave them there until you delete them from Outlook. 

If you access your POP email account from multiple computers, you will probably want to leave 
messages on the server to ensure that they’re available to you from all your computers.

TIP  If you configure Outlook to connect to a POP account from a portable computer and 
experience difficulty sending email messages when connected to a public network (such as 
a hotel network), it might be because the network has blocked traffic on the default out-
going server port, port 25. If so, you can likely resolve the issue by changing the outgoing 
server port on the Advanced page of the Internet E-mail Settings dialog box for the account 
to port 80, 465, or 587.

After supplying the connection information for your email account and closing the Internet 
E-mail Settings dialog box, you can click Test Account Settings or Next on the POP And 
IMAP Account Settings page of the Add Account wizard to ensure that Outlook successfully 
connects to your incoming and outgoing servers.
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Validating the successful configuration of an Internet email account.

Working in the Outlook 2013 user interface
The goal of the Office 2013 working environment is to make working with Office docu-
ments, including Microsoft Word documents, Excel workbooks, PowerPoint presentations, 
Outlook email messages, and Access database tables, as intuitive as possible. To that end, 
each program in the Office system, including Outlook, has a similar user interface. 

Unlike other Office programs, Outlook doesn’t function for a single purpose or create a 
single category of files. You use it to create, organize, and track several types of informa-
tion that are critical to keeping your daily life functioning smoothly. To minimize the work 
of dealing with such diverse items of information as email messages, contact records, ap-
pointments, tasks, and notes, Outlook provides a module for each type and presents each 
module in a similar interface, allowing you to work with different items of information in 
consistent ways. 

As an information-management system, Outlook has more complex functionality than 
other Office applications; it also has more elements in its user interface. However, some 
are hidden by default, and you can choose the elements you want to display.

SEE ALSO  For information about hiding and displaying user interface elements, see 
“Personalizing the Outlook program window” in Chapter 11, “Customize Outlook.”
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In the default configuration of the Outlook 2013 program window, many of the program tools  
are minimized or hidden.

The program window is bordered by the standard Office program window elements on the 
top and bottom:

▪▪ Title bar  This bar across the top of the program window displays the name of the ac-
tive account and provides tools for managing the program and the program window.

The Outlook program window title bar.

At the left end of the title bar is the program icon, which you click to display com-
mands to restore, move, size, minimize, maximize, and close the program window.

To the right of the program icon is the Quick Access Toolbar, which by default dis-
plays the Send/Receive Folders and Undo buttons. You can customize the Quick 
Access Toolbar to display any commands you want.
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The program window and the windows in which you work with each type of Outlook 
item have individually configurable Quick Access Toolbars. For example, you can dis-
play commands specific to creating and formatting message content only in message 
item windows and commands specific to creating and managing tasks only in task item 
windows.

TIP  You might find that you work more efficiently if you organize the commands 
you use frequently on the Quick Access Toolbar and then display it below the ribbon, 
directly above the workspace. For information, see “Customizing the Quick Access 
Toolbar” in Chapter 11, “Customize Outlook.”

At the right end of the title bar are five buttons: the Microsoft Outlook Help button 
that opens the Outlook Help window; a Ribbon Display Options button that allows 
you to control the display of the ribbon; and the familiar Minimize, Maximize/Restore 
Down, and Close buttons.

SEE ALSO  For information about the Outlook Help system, see “Getting help with 
Outlook 2013” later in this chapter.

▪▪ Ribbon  Located below the title bar, the ribbon gathers all the commands for working 
with Outlook content together in a central location. 

SEE ALSO  For more information, see “Working with the ribbon” later in this section.

▪▪ Status bar  Across the bottom of the program window, this bar displays information 
about the current account and provides access to certain program functions.

The account information in the center is shown only for Exchange accounts.

SEE ALSO  For information about modifying the indicators shown on the status bar, 
see the sidebar “Customizing the status bar” in Chapter 11, Customize Outlook.”

By default, Outlook displays the Items In View, Unread Items In View, and Reminders 
indicators (whichever are valid) at the left end of the status bar. Each of these indica-
tors displays at a glance the status of that feature; clicking the Reminders indicator 
displays the Reminders dialog box in which you can process active reminders. For 
Exchange accounts, the connection status is displayed in the center of the status bar. 
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The View Shortcuts, Zoom Slider, and Zoom Level controls are displayed at the right 
end of the status bar. The View Shortcuts toolbar includes buttons for the two pri-
mary program content views. The Zoom Slider and Zoom Level controls enable you 
to adjust the magnification of the Reading Pane.

SEE ALSO  For information about the various ways you can view program window and 
item content, see Chapter 2, “Explore Outlook 2013.” We discuss the module-specific 
views in Chapter 4, “Store and access contact information,” Chapter 5, “Manage 
scheduling,” Chapter 6, “Track tasks,” and Chapter 7, “Organize your Inbox.”

Working with the ribbon
You might be familiar with the ribbon command structure from other Office programs. 
Outlook differs from those in one respect—it has one ribbon for the program window, and 
a separate ribbon for each item window. As a result, each Outlook ribbon is simpler and 
contains fewer tabs than the ribbons in other programs.

The program window and each of the Outlook item windows have individually configurable 
ribbons that display content specific to the program or to the item type you’re working 
with. All the ribbons share common structural features.

The Home tab of each ribbon displays the most frequently used commands.

TIP  Your ribbons might look different from those shown in this book. You might have 
installed programs that add their own tabs to the ribbon, or your screen settings might 
be different. For more information, see “Ribbon appearance” later in this section.

▪▪ Across the top of the ribbon is a set of tabs. Clicking a tab displays an associated set 
of commands. The Home tab of each ribbon contains the most commonly used com-
mands for the related item.

▪▪ On each tab, buttons representing commands are organized into named groups. The 
groups that appear on each tab, and the buttons that appear in each group, vary 
based on the active module or item.
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▪▪ Depending on your screen resolution and the size of the program window, the com-
mands in a group might be displayed as labeled buttons, as unlabeled icons, or as 
one or more large buttons that you click to display the commands within the group.

▪▪ You can point to any button to display a ScreenTip containing the command name, 
a description of its function, and its keyboard shortcut (if it has one).

ScreenTips provide helpful information about buttons.

SEE ALSO  For information about controlling the display and content of ScreenTips, 
see “Configuring Office and Outlook options” in Chapter 11, “Customize Outlook.”

▪▪ Some buttons include an integrated or separate arrow. To determine whether a but-
ton and arrow are integrated, point to the button to display its border. If a button and  
arrow are integrated within one border, clicking the button displays a list of related 
options. If the button and arrow have separate borders, clicking the button carries out 
the default action indicated by the button’s current icon. You can change the default 
action of the button by clicking the arrow and then clicking the action you want.

The arrow of the Use Voting Buttons button is integrated, 
and the arrow of the Permission button is separate.

▪▪ Related but less common commands are not represented as buttons in a group. 
Instead, they’re available in a dialog box or pane, which you display by clicking the 
dialog box launcher located in the lower-right corner of the group.

▪▪ To the right of the groups on the ribbon is the Collapse The Ribbon button. Clicking 
this button hides the commands but leaves the tab titles visible. When the groups are 
hidden, the Collapse The Ribbon button changes to the Pin The Ribbon button, which 
is shaped like a pushpin. You can click any tab title to temporarily display the groups, 
then click a ribbon command or click away from the ribbon to hide the groups again, 
or click the Pin The Ribbon button to permanently redisplay the groups.
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KEYBOARD SHORTCUT  Press Ctrl+F1 to unpin or pin the ribbon. For more information 
about keyboard shortcuts, see “Keyboard shortcuts” at the end of this book.

Module and item tabs
Commands related to working with the content of Outlook items are represented in 
function-specific groups on separate feature-specific tabs of the ribbon.

▪▪ The ribbon in each module includes four standard tabs: Home, Send/Receive, Folder, 
and View. The Home tab changes to reflect the commands necessary to manage 
items within the current module.

▪▪ The ribbon in each new Outlook item window includes an item-specific tab such as 
Message, Appointment, Contact, or Task. It also includes the Insert, Format Text, and 
Review tabs. The ribbon might also contain additional tabs specific to an item type, 
to a program installed on your computer, or to customizations you’ve made in the 
Outlook Options dialog box.

SEE ALSO  For information about adding standard tabs, removing standard tabs 
and groups, and creating custom tabs and groups, see “Customizing the ribbon” 
in Chapter 11, “Customize Outlook.”

▪▪ When certain types of item content (such as tables, charts, and graphics) are active 
(selected), additional tool tabs appear at the right end of the ribbon. These tool tabs 
are indicated by colored headers and a colored bottom border, and they contain 
commands that are specific to working with the selected content. For example, when 
the cursor is in a table, the Design and Layout tool tabs for tables appear to the right 
of the Review tab. When a chart or chart element is selected, the Design, Layout, and 
Format tool tabs for charts appear to the right of the Review tab. Each of the available 
tool tab groups has a unique color so you can easily differentiate between them.

The ribbon was designed to make working with Outlook items and item content a natural 
extension of the way most people work. Commands for tasks you perform often are readily 
available, and even those you might use infrequently are easy to find.

For example, when a formatting option has several available choices, they are often dis-
played in a gallery of thumbnails. These galleries provide a visual array of the available 
choices. When a gallery contains more thumbnails than can be shown in the available 
ribbon space, you can display more content by clicking the scroll arrow or More button 
located on the right edge of the gallery.
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If you point to a thumbnail in a gallery, the Live Preview feature shows you what that choice 
looks like if you apply it to the active content.

Live Preview shows the effect of clicking the thumbnail to which you are pointing.

TIP  Some older commands no longer appear as buttons on the ribbon but are still avail-
able in the program. You can make these commands available by adding them to the 
Quick Access Toolbar. For more information, see “Customizing the Quick Access Toolbar” 
in Chapter 11, “Customize Outlook.”

Ribbon appearance
The ribbon is dynamic, meaning that as its width changes, its buttons adapt to the available 
space. As a result, a button might be large or small, it might or might not have a label, or 
it might even change to a command on a menu. When sufficient horizontal space is not 
available to fully display the ribbon commands, small button labels disappear and entire 
groups of buttons might hide under one button that represents the entire group. Clicking 
the group button displays a menu of the commands available in that group. When the rib-
bon becomes too narrow to display all the groups, a scroll arrow appears at its right end. 
Clicking the scroll arrow displays the hidden groups.
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The width of the ribbon depends on these three factors:

▪▪ Program window width  Maximizing the program window provides the most space 
for the ribbon. To maximize the window, click the Maximize button, drag the borders 
of a non-maximized window, or drag the window title bar to the top of the screen 
until it resizes.

▪▪ Screen resolution  Screen resolution is the size of your screen display expressed as 
pixels wide × pixels high. The greater the screen resolution, the greater the amount of 
information that will fit on one screen. Your screen resolution options are dependent 
on the display adapter installed in your computer, and your monitor. Common screen 
resolutions range from 800 × 600 to 2560 × 1600. The greater the number of pixels 
wide (the first number), the greater the number of buttons that can be shown on the 
ribbon.

To change your screen resolution, first display the Screen Resolution control panel 
item (available by right-clicking the desktop and then clicking Screen Resolution). In 
the Screen Resolution window, click the Resolution arrow, click or drag to select the 
screen resolution you want, and then click Apply or OK.

▪▪ The magnification of your screen display  If you increase the screen magnification 
in Windows, text and user interface elements are larger and therefore more legible, 
but fewer elements fit on the screen. You can set the magnification from 100 to 500 
percent.

You can change the screen magnification from the Display control panel item (avail-
able within the Appearance And Personalization group, or by right-clicking the desk
top, clicking Personalization, and then clicking Display in the lower-left corner of 
the window). To change the screen magnification to a magnification that is available 
in the Display window, click that option. To select another magnification, click the 
Custom Sizing Options link and then, in the Custom Sizing Options dialog box, click 
the magnification you want in the list or drag the ruler to change the magnification 
even more (the cursor changes to a pointer to indicate that you’re dragging). After 
you click OK in the Custom Sizing Options dialog box, the custom magnification is 
shown in the Display window along with any warnings about possible problems with 
selecting that magnification. Click Apply in the Display window to apply the selected 
magnification.
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Working in the Backstage view
Commands related to managing Outlook and Outlook accounts are located in the 
Backstage view, which you display by clicking the File tab at the left end of the ribbon. 

The Backstage view, from which you can manage accounts and customize the program.

TIP  The contents of the Backstage view when opened from the program window are iden-
tical regardless of which module you’re working in. However, the Automatic Replies button 
is available only for Exchange accounts.

Commands available in the Backstage view are organized on pages, which you display by 
clicking the page tabs in the colored left pane. The Backstage view of Outlook 2013 in-
cludes the following pages:

▪▪ Info  Manage account settings, automatic replies, mailbox size, rules, and alerts.

▪▪ Open & Export  Open an external calendar file, Outlook data file, or other Outlook 
user’s folder in Outlook; import and export files, settings, and RSS feeds.
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▪▪ Save/Save As  Save the active or selected item as a file to a local, network, or 
Internet location.

▪▪ Save Attachments  Save attachments to a local, network, or Internet location.  
(Available only when the active or selected item has attachments.)

▪▪ Print  Select a printer, set print options, preview the effect of the applied options, 
and print module content or selected items.

▪▪ Office Account  Access information about your Outlook or Office installation, 
manage product activation, product keys, user settings, and connected services.

The Backstage view also includes a link to the Outlook Options window, from which you can 
manage program settings, and links to close the active item or exit the program.

SEE ALSO  For information about managing program settings, see “Configuring Office and 
Outlook options” in Chapter 11, “Customize Outlook.”

You redisplay the program or item and the ribbon by clicking the Back arrow located above 
the page tabs or the Exit command at the bottom of the left pane.

Getting help with Outlook 2013
Whenever you have a question about Outlook 2013 that isn’t answered in this book, your 
first recourse is the Outlook Help system. This system is a combination of articles, videos, 
and training tools available from the Office website for reference when you are online, and 
basic information stored on your computer for reference when you are offline. 

You can find Help resources in the following ways:

▪▪ To find out about an item on the screen, you can point to the item to display a 
ScreenTip. For example, to display a ScreenTip for a button, point to the button 
without clicking it. The ScreenTip gives the button’s name, the associated keyboard 
shortcut if there is one, and unless you specify otherwise, a description of what the 
button does when you click it.

▪▪ In the Outlook program window, you can click the Microsoft Outlook Help button (a 
question mark) near the right end of the title bar to open the Outlook Help window.

▪▪ In a dialog box, you can click the Help button near the right end of the dialog box 
title bar to open the Outlook Help window and display any available topics related 
to the functions of that dialog box.
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In this exercise, you’ll search for information by using Outlook Help.

	SET UP  You don’t need any practice files to complete this exercise. With Outlook 
running, follow the steps.

1	 Near the right end of the title bar, click the Microsoft Outlook Help button to open 
the Outlook Help window.

KEYBOARD SHORTCUT  Press F1 to display the Outlook Help window.

TIP  To switch between online and offline reference content, click the arrow to the 
right of Outlook Help and then click Outlook Help From Office.com or Outlook Help 
From Your Computer. You can print the information shown in the Help window by 
clicking the Print button on the toolbar to the left of the search box. You can change 
the font size of the topic by clicking the Use Large Text button on the toolbar.

The home page of the Outlook Help window. Your Help window might look different  
from this one because the material on the Office website is regularly updated.
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2	 At the top of the Outlook Help window, in the search box, enter printing and then 
click the Search button (the magnifying glass) to display a list of topics related to 
printing Outlook items.

A typical list of Help topic search results.

3	 Click the Print your Contacts link to display the corresponding article. Then scroll 
through the article and note the types of information it contains.

TIP  When section links appear in an article, you can click a link to move directly to 
that section of the article. You can click the Top Of Page link at the end of an article 
to return to the beginning. When Show All appears at the beginning of a Help topic, 
you can click it to display any hidden auxiliary information available in the topic, and 
then click Hide All to hide the information.
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A typical Help article.

4	 Display related information by clicking any link identified by colored text.

5	 In the Search box, enter services, and then press the Enter key to display topics 
related to the search term.

6	 In the results list, click Connect services to Office 2013 to display that topic.

7	 At the left end of the toolbar, click the Back button to return to the topics you 
previously displayed.

+ 	CLEAN UP  Close the Outlook Help window when you finish exploring.
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Key points
▪▪ You can configure Outlook to connect to Exchange, Exchange ActiveSync, POP, and 

IMAP accounts.

▪▪ You can configure multiple email accounts within one Outlook profile.

▪▪ The Add Account wizard can connect to many email accounts automatically. You 
need to provide only your email address and account password.

▪▪ You can manually configure account connection settings or additional server settings 
such as the time to retain Internet account email messages.

▪▪ Outlook organizes different types of information in modules.

▪▪ The Outlook user interface provides module-specific and item-specific command 
structures in the familiar ribbon interface.

▪▪ The Outlook Help window provides access to current information and training 
materials for many aspects of the program.
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Explore Outlook 2013

IN THIS CHAPTER, YOU WILL LEARN HOW TO

▪▪ Work in the Outlook program window.

▪▪ Work in the Mail module.

▪▪ Work in the Calendar module.

▪▪ Work in the People module.

▪▪ Work in the Tasks module.

The Microsoft Outlook 2013 user interface includes many features and tools to help you 
easily store, find, and display information. Outlook functionality is divided among several 
modules that are specific to the content you work with in them, including Mail, Calendar, 
People, and Tasks. You display and work with one module at a time in the program window. 
The program window elements of each module present content-specific functionality.

The program window ribbon in each Outlook module displays commands specific to work-
ing with the Outlook items created and stored in that module. Similarly, the ribbon in each 
type of Outlook item window has a unique tab that displays commands specific to creating 
that type of item.

In this chapter, you’ll first learn about the features and tools available in the Outlook pro-
gram window. Then, you’ll explore item window features in message windows, calendar 
item windows, contact record windows, and task windows.

PRACTICE FILES  You don’t need any practice files to complete the exercises in this chapter.
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Working in the Outlook program window
The first time you start Outlook, the program window displays the contents of the Mail 
module in Reading view, which hides or minimizes many of the tools you can use to man-
age your messages and other Outlook items. (The other available program window layout is 
Normal view.) When you subsequently start Outlook, the program window displays the view 
and arrangement of the Mail module that was active when you closed the program.

TIP  In Outlook, the named views control the way the program window is laid out rather 
than the way actual content is displayed. After choosing a view, you can display and hide 
program elements, and also control the way Outlook displays information in the content 
area, by using commands on the View tab.

Any modifications you make to the display of elements in the Outlook program window are 
visible in Normal view. You can switch between these standard views by clicking the buttons 
on the View Shortcuts toolbar near the right end of the status bar.

TIP  In addition to the two program window layout views, each module has standard con-
tent area view options. For information about the available views, see the individual module 
sections later in this chapter.

Program window elements
You can individually control the display, and in some cases the location, of program window 
elements from the View tab. In addition to the title bar, ribbon, and status bar that are com-
mon to all Microsoft Office programs, the Outlook program window includes four areas in 
which you work with Outlook items.

▪▪ Folder Pane  This collapsible pane appears on the left side of the Outlook program 
window in every module. Its contents change depending on the module you’re view-
ing—it might display links to email folders, Microsoft SharePoint lists and libraries, 
external content, or view options. By default, the Folder Pane is minimized to display 
only favorite folders. The Folder Pane setting (Normal or Minimized) remains the 
same as you switch among modules.

When the compact Navigation Bar is displayed, it is incorporated into the Folder 
Pane and displayed vertically when the Folder Pane is minimized or horizontally 
when the Folder Pane is open.

SEE ALSO  For more information, see “Navigation Bar” later in this section.
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In the Mail module, the Outlook program window displays the message list and the  
Reading Pane.

▪▪ Content area  The content area is the part of the program window bordered on the 
left by the Folder Pane and on the right by the To-Do Bar, when the To-Do Bar is 
displayed, or by the right side of the program window when it is not displayed. The 
content area displays the content of the selected module—your message list, calen-
dar, contact records, or tasks—and can also host the Reading Pane. 

▪▪ Reading Pane  This optional pane can be displayed vertically or horizontally within 
the content area. Within the Reading Pane, you can preview and work with the con-
tent of a selected item, or display a full-featured preview of a file that is attached to 
an Outlook item (including Microsoft Word documents, Microsoft Excel worksheets, 
Microsoft PowerPoint presentations, and PDF files). The Reading Pane can also host 
the People Pane.

The Reading Pane can be displayed in any Outlook module but is displayed by 
default only in the Mail and Tasks modules.
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SEE ALSO  For information about working with the Reading Pane, see “Viewing mes-
sages and message attachments” in Chapter 3, “Send and receive email messages.”

▪▪ To-Do Bar  This optional pane displays the Calendar peek, People peek, and Tasks 
peek, or any combination of these that you choose. In Outlook 2013, the To-Do Bar 
can be either open or closed, but not minimized as it could be in previous versions 
of Outlook.

The To-Do Bar can be displayed in any Outlook module, but is not displayed by 
default.

SEE ALSO  For information about working with tasks on the To-Do Bar, see “Display-
ing different views of tasks” in Chapter 6, “Track tasks.”

TIP  If you find that the default Outlook window layout isn’t perfectly suited for the way you 
work, or  you’d just like to try a different layout, there are many ways in which you can per-
sonalize the appearance and functionality of Outlook. For more information, see “Personal-
izing the Outlook program window” in Chapter 11, “Customize Outlook.”

Navigation Bar
The Navigation Bar, which is new in Outlook 2013, is located near the lower-left corner of 
the program window, above the status bar. In previous versions of Outlook, the navigation 
controls were incorporated into the Folder Pane (formerly called the Navigation Pane). In 
Outlook 2013, the navigation controls are presented on the Navigation Bar, which can ap-
pear as a compact vertical or horizontal bar that displays only module icons, or as a larger 
horizontal bar with text labels.

The standard Navigation Bar is separate from the Folder Pane and does not change orienta-
tion. The compact Navigation Bar is incorporated into the Folder Pane and its orientation 
depends on whether the Folder Pane is minimized or expanded. To display more or fewer 
buttons on the vertical compact Navigation Bar, drag its top border up or down up. To dis-
play more or fewer buttons on the horizontal compact Navigation Bar, change the width of 
the Folder Pane.


